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1 Introduction 

This guide outlines the best practices and requirements for deploying Nitro PDF Pro for Windows. These 

settings can be customized to fit the specific needs and preferences of individual customers. 

To meet the diverse license management and deployment needs of various organizations, Nitro PDF Pro 

offers multiple installation options. This Installation Guide is specific to the Business licensing model.  

If further assistance is needed, please see Section 7 for additional support resources. 

2 System Requirements 

• Operating System (Desktops): Windows 11 (64bit) and Windows 10 (64bit) 

version 1809 or later 

• Servers: Microsoft Windows Server 2016 (64bit) and 2019 (64bit)  

• Processor: 1.5 GHz or faster  

• RAM: 1GB  

• Available Hard Disk Space: 4.5GB  

• Display Screen Resolution: 1024x768  

• Microsoft Office Integrated Features: MS Office 2013 (32bit or 64bit), MS 

Office 2016 (32bit or 64bit), Microsoft Office 2019 (32bit or 64bit)  

• Video Hardware Acceleration:  Optional  

• iManage: To support iManage integration: 

o server:  iManage 10.2 and newer (cloud or on-premises) 

o client:  iManage Work Desktop for Windows 10.5 and newer 

• Microsoft Visual C++ Redistributable (version 14.42.34433 or later) 

o x64-bit VC++ redistributable required for all users 

o x86-bit VC++ Redistributable required for use with Office x86 

 

 

Please check the Technical Requirements page for the latest Nitro PDF Pro system requirement updates. 

 

3 Installing Nitro PDF Pro 14 (for Windows) – Business Version 

Nitro offers different licensing methods for its software. This guide is specifically for the Business version of 

Nitro PDF Pro which is installed using a MSI (Microsoft Installer) deployment package and activated using 

an 18-digit numeric serial number. If you do not have an 18-digit numeric serial number, you will not be able 

to activate Nitro PDF Pro. 

 

3.1 Nitro PDF Pro 14 (for Windows) Installers (Business) 

Nitro PDF Pro 14 can be installed on individual computers or deployed to multiple computers without any 

user interaction using a software deployment application or Group Policy. 

https://www.gonitro.com/product-details/technical-details
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The latest Business version of Nitro PDF Pro 14 (for Windows) can be downloaded at: 

https://www.gonitro.com/installers/business/v14/msi/download. 

Please note: Please ensure the Microsoft Visual C++ Redistributable (x64) is up to date before installing 
Nitro PDF Pro. 

 
3.1.1 Default Settings 
 
We recommend installing Nitro PDF Pro 14 using the default settings. Below is a list of features that are 

enabled in Nitro PDF Pro 14 (Business) by default: 

• Nitro PDF Pro desktop shortcut 

• Microsoft Office (Word, Excel, PowerPoint, Outlook) add-in 

• Nitro PDF Pro printer driver (required for creating documents) 

• Crash reporting  

• Integrations with supported Document Management Systems (DMS), including 

Box, Dropbox, OneDrive, and SharePoint Online. 

• Nitro Knowledge Assistant  

 

3.2 Installation Methods 

To install Nitro PDF Pro 14, you have multiple options to choose from depending on your preferred method 

and technical expertise. Below are the three ways to install the software: 

1. Manual /Basic Installation: Run the MSI file and follow the installation wizard 

prompts. 

2. Command-Line: Use the command-line or a script to run the msiexec command. 

3. Software Package: Deploy via a software package like Microsoft System Center 

Configuration Manager (SCCM) or Intune. 

 

3.2.1 Manual / Basic Installation (Default Settings) 

Nitro PDF Pro 14 can be installed on a Windows-based computer that meets the prerequisites by simply 

starting the MSI installation file with a double click. This method is typically recommended when installing 

on individual workstations. 

https://www.gonitro.com/installers/business/v14/msi/download
https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170#latest-supported-redistributable-version
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1. Download the Nitro PDF Pro 14 installer. 

 

2. Close all Microsoft Office applications 

(Word, Excel, PowerPoint, Outlook). 

Run the downloaded package with 

elevated privileges. (Run as an 

Administrator if your user account does 

not have installation rights. 

 

3. Follow the prompts presented by the 

installer. 

4. Select the installation location. The default 

(recommended) location is C:\Program 

Files\Nitro\PDF Pro\14\.  

 

5. Leave the box checked to install the 

Microsoft Office add-ins for Word, 

Excel, PowerPoint, and Outlook. 

 

6. Select the desired application 

language from the drop-down. 

English is the default language, but 

Nitro PDF Pro is also available in 

German, French, Spanish, Dutch, 

and Italian. (The application 

language can also be changed post-

installation. See Section 6.1 for 

details.) 

 

7. Click Install to begin the installation 

process. 

 

8. Please wait for the installation of Nitro PDF Pro to complete, then click Finish. 

 

3.2.1.1 Activating Nitro PDF Pro Manually on Individual Workstations) 

Nitro PDF Pro is activated using an 18-digit. This is a straightforward process designed to ensure you can 

access and utilize the full capabilities of Nitro PDF Pro. This method provides a seamless and secure way 

to activate Nitro PDF Pro.  

Follow the steps below to activate Nitro PDF Pro and get started. 

1. After Nitro PDF Pro 14 is installed, go to the Help tab, and click on the Activate button. 

 

2. You will be presented with an Activation window. 

 

https://www.gonitro.com/installers/business/v14/msi/download
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3. Enter the 18-digit serial number. 

 

4. Check the box to accept the 

Terms of Service. 

 

5. Click Activate to activate the 

Nitro PDF Pro installation. 

 

6. Upon successful activation, a 

message will appear confirming 

that Nitro PDF Pro has been 

activated. 

 

 

 

4 Setting Nitro PDF Pro as 

the Default PDF Application 

Due to changes made by Microsoft, Nitro PDF Pro cannot be set as the default PDF viewer automatically 

during installation. A few additional steps are required to make Nitro PDF Pro the default PDF application.  

 

4.1 Setting Nitro PDF Pro as the Default:  

On Individual Workstations  

 

Option 1: Change the Default PDF Application from 

Preferences 
 

   

1. Open Nitro PDF Pro and go to Preferences. 

 

2. Select General from the left-hand column. 

 

3. Click Set Default Programs and follow the 

prompts to set Nitro PDF Pro as the default 

PDF viewer. 

 

 

Option 2: Change the Default PDF Application Using "Open with" in File Explorer   
 

1. After Nitro PDF Pro is installed on the workstation, from File Explorer right-click on any 

PDF file, and from the context menu, select Open With.  

 

2. Select Choose another app to open the prompt window with a list of PDF applications. 

 

3. Select Nitro PDF Pro from the list and click Always use this app to open .pdf files.  
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4. The above steps can be repeated to set Nitro PDF Pro 14 as the default application for  

FDF, XFDF, and PPDF files.  

 

 

Option 3: Change the Default PDF Application 

through Settings  
 

1. Click on the Start menu. Go to Settings > 

Apps > Default apps. 

 

2. Select Set defaults by app. 

 

3. Select Nitro PDF Pro and click Manage.  

 

4. Select Nitro PDF Pro as the default app for 

PDF, FDF, XFDF, and PPDF files.  

 

5 Updating Nitro PDF Pro 

(Business version) 

 
The latest Nitro PDF Pro 14 installers, product updates, and release notes are available at the Business 

Installer page. The latest release of Nitro PDF Pro can be downloaded here. 

 

 

5.1 In-App Updater 

 

Nitro releases a minor update (e.g., Nitro PDF Pro 14.1 to Nitro PDF Pro 14.2) approximately every three to 

six weeks. Nitro PDF Pro includes an In-App Updater feature that notifies users when there is a newer version 

of Nitro PDF Pro available for installation.  

 

There are two methods of notification: 

 

1. Automatic: When opening Nitro PDF Pro, users will be notified at startup if a newer 

version is available. 

 

2. Manual: Users can manually check whether a newer version of Nitro PDF Pro is 

available by going to the Help tab from within Nitro PDF Pro, then clicking on Check for 

Updates. 

 

 

 

https://www.gonitro.com/installers/business/v14/msi/download
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If a newer version is available, users will be presented with an option to install the latest Nitro PDF Pro 

update.  

 

Users can dismiss the notification by 

selecting Skip this version to 

suppress any additional notifications 

about this version update or Remind 

me later to get another notification in 

24 hours. 

 

If Install update is selected, users will 

be guided through the download and 

installation steps. Nitro PDF Pro will 

be installed on the user’s workstation 

using the standard default 

installation settings.  

 

 

 

 

 

5.2 Retaining Configuration Settings during Version Updates 

When updating Nitro PDF Pro, the following user data and settings are retained for both major and minor 

version updates. No action is needed to retain the following user settings. 

 

• QuickSign Profiles 

• Custom Stamps 

• Digital IDs 

• Digital Signatures 

• Certificates 

• Security Profiles 

• Scanner Profiles 

 

 

6 Special Configurations 

 

6.1 Multilingual Installer: Selecting Application Language 

 
Nitro PDF Pro 14 is available in six languages: English, German, French, Spanish, Italian, and Dutch. 

The application language can be changed at the time of deployment or changed by the user at any time after 

installation. 
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6.1.1 Setting the Application Language on Individual Workstations 

Nitro PDF Pro delegates the choice of the application language to an end-user. Unless the application 

language is specified at the time of deployment, the user is prompted to select a preferred language at the 

first launch of Nitro PDF Pro. Users can also 

change the application language at any time after 

first use by going to Nitro PDF Pro Preferences. 

 

1. Go to File > Preferences. 

 

2. Select Language from the left-hand 

column. 

 

3. Select the desired Application Language 

from the drop-down menu. 

 

4. Click Apply and OK. 

 

5. Restart Nitro PDF Pro to apply the 

changes to the application language. 
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6.2 iManage 10 - Integration  

 
Nitro PDF Pro supports an integration with iManage 10. Integrating Nitro PDF Pro with iManage ensures that 

all PDF files are automatically saved and indexed in a secure, centralized location, making it easy for users 

to find and retrieve documents.  

 

The Nitro PDF Pro iManage 10 integration provides a seamless workflow for the end-users to Open and Save 

documents from iManage repositories.  

 

For Step-by-step instructions for setting up the iManage server to communicate with Nitro PDF Pro, please 

see the Nitro User Guide. 

 

Once the iManage integration is enabled, Nitro PDF Pro will display an additional iManage tab with the 

available features as below:  

  

  

  

7 Contacting Nitro Support 

 

If you encounter any issues or have questions, Nitro has a full suite of self-help resources, including videos, 

user guides, knowledge base articles, and community forum.  

   
• User Guide: Get step-by-step instructions for using Nitro PDF Pro with our 

comprehensive Nitro PDF Pro User Guide.  

 

• Video Library: Choose from a collection of short videos to learn how to use core 

features in Nitro PDF Pro.  

 

• Knowledge Base: Get on-demand answers to your product-related questions 

across hundreds of knowledge base articles.    
 

• Nitro Knowledge Assistant: Use our chat tool for an improved search experience 

and quick and accurate results across our extensive knowledge base.    
 

 
  

 

https://www.gonitro.com/user-guide/pro/integrations/deploying-imanage-work-10
https://www.gonitro.com/user-guide
https://www.gonitro.com/support/video-library
http://kb.gonitro.com/knowledgebase
https://nitro-assistant.gonitro.com/
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